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Notes and cautions

The following note applies to ElixiFont.

Elixir HP driver

The Elixir HP driver is no longer available when print-
ing from the font sampling pad, accessible through the
Sample tool.
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1. Introduction

This User Guide describes ElixiFont, a sophisticated
Windows-based bitmap font editor that allows you to
create and edit fonts in what-you-see-is-what-you-get
(WYSIWYG) format.

ElixiFont allows you to perform the following opera-
tions to fonts:

® edit individual characters in a font by providing
tools to manipulate each character bitmap

® apply transformations to one, all, or a sequence
of characters in a font, enabling you to embolden,
italicize, wunderline and to perform other
transformations

e display and change character or font properties
such as kerning, baseline offset, orientation, etc.

For fonts converted from Xerox format, ElixiFont also
allows you to display and change Xerox header
information.

The ElixiSys Desktop enables you to import fonts and
convert them to Elixir's generic font format. In this for-
mat, you can display or edit fonts on your PC and re-
convert them back to the original or other formats.
See the printer specific sections of the ElixiSys Desk-
top User Guide for information about formats to and
from which you can convert Elixir fonts.

Note that the minimum point size supported in Elixi-
Font is 4 points, and the maximum point size sup-
ported is 99 points.
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INTRODUCTION

Customer support

Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.

® If you have purchased your Elixir product directly
from Xerox Corporation then you should contact
the Xerox customer support center telephone
number provided by Xerox.

® If you have purchased your Elixir product directly
from Elixir Technologies then contact one of the
support center hotlines.

See the Elixir Getting Started Guide for information
about contacting your support center.

ElixiFont environment

ElixiFont is designed to work with the ElixiSys Desk-
top, a Windows-based desktop. The ElixiSys Desktop
simplifies file conversions and management by pre-
senting the user with icons which you can manipulate
with simple mouse drag-and-drop techniques (see the
ElixiSys Desktop User Guide for more information).

Other Elixir products you can use with the ElixiSys
Desktop are:

® ElixiGraphics, a Windows-based bitmap graphics
editor which you can use to tile Elixir-format
graphics into Elixir-format fonts (see the Elixi-
Graphics User Guide for more information).

® ElixiForm, a forms creation package that enables
users to create and edit boilerplate forms using
standard FSL form elements. See the ElixiForm
User Guide for more information.

1-2
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INTRODUCTION

Who should use this guide

This guide is intended for users familiar with Xerox
font resources.

Knowledge of Windows and DOS, especially naviga-
tion through directory and subdirectory structures and
file operations is also required.

Conventions

This section describes display and typographical con-
ventions used in this guide.

Display conventions

ElixiFont adheres to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons, and a mouse. See your
Windows manual for more information.

Typographical conventions

The following typographical conventions are used
throughout this guide:

® Keystrokes are shown enclosed in < > (angle
brackets). For example, <Enter>.

® Key combinations are denoted by a plus sign be-
tween keys. For example, <Shift> + <F1> indi-
cates to simultaneously press the <Shift> and the
<F1> keys.

® Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example,

Pull down the File menu and select [New font].

ELIXIFONT USER GUIDE 1-3



INTRODUCTION

e Commands, options, actions, and parameters
that require description are shown in bold fol-
lowed on the next line by the description. For ex-
ample:

Delete
Deletes the selected characters.

® Steps in a procedure are shown in numbered bold
paragraphs. For example

1. Pull down the Window menu and select [Tile].
Comments relating to a step (such as this para-

graph) are shown in regular text following the bold
paragraph.

On-line help

ElixiFont uses the Microsoft Window Help program to
provide on-line Help for functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with ElixiFont include graphics
which were created using screen drivers with large
fonts. If you use a screen driver with small fonts, the
Help file graphics may not display clearly. For opti-
mum graphics display, use a screen driver that uses
large fonts. .

You can display on-line Help in the following ways:

Bubble Help

Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help".
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.

1-4
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Quick Help

Enable the quick help function by selecting the [Show
Quick Help] option in the Usage Switches dialog box.
When you move the screen pointer over an icon on
the screen, a short description of the icon function dis-
plays in the Message area of the screen. During cer-
tain operations a message about the function you are
performing also displays in the Message area. You
can disable Quick Help if you prefer to see these op-
erational messages.

Context sensitive Help

To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays. If no
specific topic is available, the Help table of contents
displays.

Help menu
Select [Help] from the ElixiFont menu bar and select
one of the displayed topics.

Dialog box Help

Click on the [Help] button in a dialog box to view an
associated Help topic. Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps

Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays within the current Help
topic with additional information. When you click on a
jump, a different, associated Help topic displays.

Help Hypergraphics

Hypergraphics are special graphics within Help files
that contain "hot spots”. Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions). Move the cursor over a hyper-
graphic until a hand displays, then click on this hot
spot to display a pop-up topic, or a "jump".

To close a pop-up topic, click the mouse button. To
return to the original Help topic from a jump, click on
<Back> in the Help file menu.
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Organization of this Guide

This guide provides the following information:
e an overview of Elixir font structure

®  how ElixiFont handles fonts converted from other
formats

® ElixiFont features and how to use them.
This User Guide is organized as follows:

Chapter 1, "Introduction," is an overview of ElixiFont
and provides information about hardware and soft-
ware requirements for successful installation. The
chapter also describes installing and starting ElixiFont
and gives additional information about the contents of
this manual.

Chapter 2, "ElixiFont basics," describes the layout and
components that make up the ElixiFont main screen.

Chapter 3, "Creating and editing fonts," describes how
you can create or edit a character or an entire font.

Chapter 4, "Transforming fonts," describes how to
apply a variety of transformations to individual char-
acters and to the entire font.

Chapter 5, "Frequent operations and advanced func-
tions," describes some of the frequent operations and
advanced functions available with ElixiFont.

Glossary.

1-6
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Installing ElixiFont

The current release of ElixiFont installs during ElixiSys
Desktop installation. No additional installation is
required.

See the Xerox Elixir Getting Started Guide for installa-
tion information.

Starting ElixiFont

You can only start ElixiFont from the ElixiSys Desktop.
To start ElixiFont from the Desktop:

Open (double-click on) the ElixiFont icon at the right of
the Desktop.

The ElixiFont main screen shown in the following fig-
ure displays.

Select mode

Figure 1-1. ElixiFont main screen
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Alternatively, with the Desktop displayed, open the
Elixir Fonts folder to display the Elixir Fonts window.

'

N
CIDAGTIA.HDR TURLHDR HEB7ELHDR HEB7ER.HDR HE B7HLHDR
HE 87 HP.HDR. HEBFOL.HDR HEBFOP.HDH HE B8BL.HDR. HE 88EP.HDR.
HE B3HLHDR HEBEHP.HDR HETIBLHD#R HETIBP.HDR HETZOLHDR
HE12DP.HDR HE13EL.HDR HE13EP.HDR. HEZ4EL.HDR HEZZEP.HDR

LIOH.HDR ROUNDLHDR SYIZHL.HDR SWIZHEP.HDR AMHARTLHD®R

Figure 1-2. Elixir Fonts folder

Open (double-click on) any .HDR font file. The Elixi-
Font main screen displays with the font loaded.

[©]

ASCH: . Dect 46 Hext 2F Wid: 16 HOMBLANK

Select mode

Figure 1-3. Loaded font

See the "Creating and editing fonts" chapter for a de-
scription of the ElixiFont screen layout.
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Exiting ElixiFont

To exit ElixiFont, double-click on the Exit button at the
top left of the ElixiFont main screen, or pull down the
File menu and select [Exit].
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2. ElixiFont basics

This chapter describes the layout and components
that make up the ElixiFont main screen.

Main screen components

The ElixiFont main screen contains the following com-
ponents:

®  ElixiFont menu bar
e Toolbox
e \Work area menu bar

Start the ElixiFont application by double-clicking on
the ElixiFont icon. The main screen displays.
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Work area

1

Figure 2-1. ElixiFont main screen

ElixiFont menu bar

The ElixiFont menu bar controls:

loading and saving fonts
usage switches and defaults
window display

access to Help files.

Figure 2-2. ElixiFont menu bar
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ELIXIFONT BASICS

File menu

System menu

The File menu allows you to:

® |oad and save fonts
e  exit ElixiFont

Open Font

When you select this option, the Load Font dialog box
listing .HDR files displays. Select a font and click on
[OK].

Save Font

Select this option to save the loaded font with the
same name unless it is a new font and then you are
prompted for a new name. This option acts as the
quick-save feature.

Save Font as

Select this option to save the loaded file with a new
name.

Exit <Alt + F4>

Select this option to exit ElixiFont and return to the
Desktop.

The System menu allows you to set usage switches,
reset to defaults, and save customized configurations.

Usage Switches

When you select this option, the Usage Switches dia-
log box displays.
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= Usage switches

Figure 2-3. Usage Switches dialog box

The Usage Switches dialog box contains the following
options:

Save State on Exit

Select this option to save your customized settings.
Deselect this option to return settings to ElixiFont
defaults.

Show Quick Help

Select this option to display a short description of an
icon as your cursor passes over it, in the message
area.

Always Bring Toolbox to Top
Select this option to display the Toolbox on top of any
window.

Truncate Long Font

Select this option to truncate characters with ASCII
values over 255 (hex FF) when loading a font that
contains more than 256 characters.

Reset to Defaults

When you select this option, all configuration parame-
ters are reset to the ElixiFont default values.

Save Configuration

Select this option to save your customized settings
rather than resetting to ElixiFont defaults.

2-4

ELIXIFONT USER GUIDE



ELIXIFONT BASICS

Window menu

The Window menu controls the way each open win-
dow displays. You can:

e tile all displayed windows

e toggle the display on or off for the Toolbox and
Work Area.

Help menu
The Help menu loads the online Help file for the Elixi-
Font application. You can choose [Contents] or any of
the topic options.

Toolbox
The left side of the screen displays the Toolbox which
contains buttons you can select to view, edit, and ma-
nipulate individual characters or the entire font.

Tools

The top of the Toolbox contains the tools you can se-
lect. These display in two rows as shown in the fol-
lowing figure:

Edit Bitmap kil Character

SeITct Transform| Properties
1

NI [
o e N

| I
Copy Merge Font Properties
Swap Sample

Figure 2-4. ElixiFont tools
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Toolbox options

Selecting a tool displays the options for that tool in the
Toolbox. Most tools also contain the options shown
below.

Suspend current
conversion

Apply current tool

Undo last operation or conversion

Options

In this area, diff-
erent options

display depending
on the tool you select

Figure 2-5. Toolbox example

If you suspend the current conversion, the Undo op-
eration may not be available.

The ElixiFont tools are described in more detail in the
following chapters of this guide.

Work Area menu bar

You use the Work area menu for creating, editing,
merging, transforming and saving fonts. This menu
also allows access to information about the properties
and statistics of a complete font and lets you view a
sample of how the font will print.

& Font Window

Figure 2-6. Work area menu bar
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Font menu

Edit menu

The Font menu options allow you to create and save
a font, merge characters from various fonts, access
information about font properties and statistics, and
view a sample of how the font will print.

New Font

Allows you to create a new font through use of several
dialog boxes requesting information about your new
font. Once you have entered the required information,
the new font displays.

Merge Fonts

Allows you to load another font (source font) and drag
and drop one or more characters from the source font
to the loaded font (target font).

Properties

Displays the Font Properties dialog box which pro-
vides orientation, resolution, header and other infor-
mation for the loaded font.

Statistics

Displays the Size of Elixir Format Font dialog box
which provides the size (bytes) various font and char-
acter components, and the total size of the loaded
character set.

Sample
Displays a sample pad showing the characters as they
will print on a page.

Convert
For future implementation.

The Edit menu allows you to undo actions and delete
or select/unselect characters or entire fonts.

Undo
Undoes the last edit operation.

Delete
Allows you to remove a selected character from a
character set.
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Char menu

Allows you to select all characters in the character set.

Unselect All
Allows you to unselect all selected characters in the
character set.

The Char menu displays properties and allows editing
of an individual character.

Properties
Displays the Character Properties dialog box which
provides values and parameters of the selected
character.

Copy
Allows you to copy a selected font to a new location.

Kill
Allows you to remove a selected character from a
font.

Swap
Allows you to swap the position of the currently se-
lected character with that of another character.

Load Image

Displays the Load Image dialog box which allows you
to load BMP, LP3, PCX, or TIF images. Size limit is
64K.

Transforms menu

The Transforms menu allows you to perform trans-
formation options to selected characters or to a com-
plete character set. See the "Transforming fonts"
chapter for complete option descriptions.

2-8
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3. Creating and
editing fonts

This chapter describes how to create new fonts and
edit Elixir-format fonts.

Some examples of Elixir fonts are loaded in the
drive \AELIXIR\FONTS\ELIXIR directory on your PC
during installation, for example HEO7NP.

The stem name of the font provides information about
the font type. For example, HEO7NP is a Helvetica
7-point normal portrait font.

You can also generate your own Elixir-format fonts by
using the Elixir Font Generator (Efont Factory) to con-
vert Bitstream FacelLift fonts to Elixir-format fonts.
See the ElixiSys Desktop User Guide for more
information.

Font basics

This section describes Elixir font characteristics and
procedures used to display, edit, and apply metrics to
fonts. The following figure shows some important
characteristics of a character in a cell.

See the "Creating a new font" section for procedures
on how to create a new, custom font. You should fa-
miliarize yourself with the other sections in this chap-
ter before you attempt to create a new font.
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Above
baseline

Below
baseline

Blanks
Left

Baseline
Offset

Cell
Height

Cell width

Figure 3-1. Character and cell components

3-2
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The next figure shows some character and line-
spacing attributes on a printed page.

Above
base-

Linegpacing line

ABCDE

Figure 3-2. Line spacing components

Below
base-
line

The following is the line-spacing calculation formula:

Line spacing = above baseline + below baseline + leading
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Creating a new font

To create a new font:

1. Pull down the Font menu and select [New
Font].

The Properties of New Font dialog box displays.

Praperties of New Font

Type
+ REROX Font

Hame
Extemal name: [T100 |

Character’s Properties

All type: HULE

HMumber of Characters:
Height of character boxes:

Width of character boxes: |:|

Bazeline from Bolttom:

Figure 3-3. Properties of New Font
dialog box

The Properties of New Font dialog box contains
the following options:

Type
You cannot change the default setting of [Xerox
Font] for this option.

External name
This option allows you to specify the external
(DOS) stem name for the font. The maximum
number of characters for a DOS stem name is
eight characters.

Note that the maximum length for Xerox font
stem names is six characters.

Number of characters
Specify how many characters you want in your
font (the maximum is 256).
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Height of character boxes
Specify the height of the character cell in dots.

Width of character boxes
Specify the width of the character cells in dots.

Baseline from Bottom
Specify the "below the baseline" value in dots.

After specifying the properties for your font,
click on [OK].

The Font Properties dialog box displays. See the
"Font Properties toolbox" section in this chapter.

After specifying properties for your font, click
on [OK].

Blank cells (representing characters in the font)
display in a window.

Open a blank cell (double-click) to display it in
the Edit Window.

Use any of the editing tools described in this
chapter to create a customized character in
the cell.

The easiest way to add characters to your blank
cells is to use the Merge operation described in
the "Merge tool" section of this chapter.

Pull down the Char menu and select [Post] to
save the newly created character.

You can now transform the character in the cell
using any of the transformation operations de-
scribed in the "Transforming fonts" chapter.

ELIXIFONT USER GUIDE
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Loading a font

To load a font:

1. Start ElixiFont, pull down the File menu and
select [Open Font].

The Load Font dialog box displays.

= Load Font
File name |EHETITE]

Fath d:kelxinfontskelixn

Directories:

Figure 3-4. Load Font dialog box

2. From the list of Elixir fonts (files with .HDR
extensions in drive\ELIXIR\IFONTS\ELIXIR),
select a file and click on [OK] to load it.

The ElixiFont main screen displays the font as
shown in the following figure.
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[©]

AECH % Dec 37 Hext 25 Widi 31 HOMBLANK

Select mode

B
[setect ]

o/ 1
IE]E]!

Figure 3-5. A loaded font

The character bitmaps of the font are arranged left-to-
right and top-to-bottom by the ASCII position of the
character in the font (the positions are defined in the
font header .HDR file). The maximum number of
characters in a font is 256.

You can use <Page Up>, <Page Down>, <Home>,
and <End>, or the scroll buttons to scroll through a
font if necessary.

Placing the screen pointer on a character displays a
dark box around it (this is now the current character).
The Message area shows the position of the current
character in ASCII, Decimal and Hexadecimal values.

Also shown is the width (in dots) of the character, and
character type: NULL, SPACING, or NONBLANK. A
null character indicates that no character is defined for
this position and displays as a filled gray cell (like the
first 32 characters in the displayed font).

A spacing character occupies a cell but does not have
a bitmap and prints as a blank space. All other char-
acters are nonblank and contain bitmaps.
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Toolbox

Select toolbox

The Toolbox contains buttons you can select to view,
edit, and manipulate individual characters or the entire
font. See the "ElixiFont basics" chapter for an over-
view of the Toolbox.

This section describes the Toolbox tools and ElixiFont
menus used for editing, transforming, and setting font
properties.

A

Select tool

Select all characters
Unselect characters

The Select tool allows you to select one or more char-
acters in a loaded font.

Figure 3-6. Select tool and options

Use the <Ctrl> + <A> fast key to select and deselect
all characters in a font (toggle).

Select a range of characters by clicking on the first
character, then <Ctrl>-clicking on the last one.

3-8
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Edit toolbox

|1 The Edit tool allows you to edit individual character
bitmaps.

Select a character and then select the Edit tool to edit
the character. If you do not select a character, the
software defaults to the first nonspace or non null
character. Alternatively, double-click on the character.
The Edit Window displays at the right of the screen.

Edit Tool Edit Window Toolbar Edit Window Menu Bar

Ei_— fndow]Help] - [ |
__
[

Coords

Framing window

Figure 3-7. Edit Window
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The bottom of the screen shows a partial list of char-
acters with the current character selected. You can
select another character to display it in the Edit win-
dow. You can also scroll through the entire font using
the <Page Up>, <Page Down>, <Home>, and <End>
keys (or use the scroll buttons).

The right of the screen shows the framing window
which you can move to display different portions of the
character you are editing.

Initially the character displays at 8 magnification (each
dot in the bitmap displays as a black or white box 8
bits high and 8 bits wide).

The Edit toolbox contains editing tools and various
tool options. A selected tool or option displays with a
dark background. In addition, you can select options
available from menus in the Edit Window menu bar, or
from the Edit Window Toolbar displayed just below the
menu bar.

Edit toolbox options

The Edit toolbox options are shown in the following
figure:

A
S ILO
A8

Figure 3-8. Edit toolbox options

Character Properties <F2>

Select this option to display the Character Properties
dialog box with properties for the current character.
See the "Character Properties toolbox" section later in
this chapter for more information.

3-10

ELIXIFONT USER GUIDE



CREATING AND EDITING FONTS

When you view the character properties of a null or
spacing character, a Properties of Null Character or
Properties of Spacing Character dialog box displays in
place of the standard Character Properties dialog box.

[TTT] Ruler

I Select this option to display the horizontal and vertical
coordinates of the screen pointer from the top left of
the character cell (in dots). The coordinates display at
the left of the Toolbar.

The ruler also allows you to display the distance in
dots between two points. With the ruler selected, click
and hold the mouse button and move the screen
pointer. The distance of the screen pointer from the
click position displays in the Line option in the Toolbar.

Select Area

Allows you to select a rectangular area of the dis-
played character and to move or copy the area (by se-
lecting [M] or [CC] in the Toolbox) to another location
in the cell. Alternatively press <Ctrl> + <M> to acti-
vate Move mode or <Ctrl> + <O> to activate Copy
mode.

u Draw Dot
Allows you to draw a dot in the character cell. You
can select the color (black, white, or reverse current

dot), and the dot thickness from the options at the bot-
tom of the Edit toolbox.

/ Draw Line
Allows you to draw a line in the character cell. You

can select the line color (black, white, or reverse cur-
rent dot), and the line thickness from the options at
the bottom of the Edit toolbox.

D Draw Rectangle
Allows you to draw a rectangle in the character cell.

You can select the border color (black, white, or re-
verse current dot), and the border thickness (in dots)
from the options at the bottom of the Edit toolbox.
You can also fill the rectangle with white or black.
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Draw Circle

Allows you to draw a circle in the character cell. You
can select the border color (black, white, or reverse
current dot), and the border thickness (in dots) from
the options at the bottom of the Edit toolbox. You can
also fill the circle with white or black.

Draw Brush

Allows you to draw with a brush. You can set the
brush thickness and color (black, white, or reverse
current dot) from the options at the bottom of the Edit
toolbox. The effect of drawing with a brush in reverse
mode depends on the speed at which you draw.

Blend

Allows you to blend another character into the current
cell. After selecting the Blend tool, select another
character from the font. The character displays on top
of the current character in the framing window. After
positioning it, click on [Accept] at the bottom of the
Edit toolbox to blend it with the first character.

After editing or viewing the bitmap, close the Edit win-
dow to return to the ElixiFont main screen.

Transform

Allows you to apply the transformations described in
the "Transforming fonts" chapter to the character
bitmap.

Edit Window menu bar

The Edit Window menu bar (at the top of the window)
contains the following pull-down menus and options:

Char
Post
Blend
Prev Char <Ctrl> + <P>
Next Char <Ctrl> + <N>
Properties <F2>

3-12
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Edit

Undo <Ctrl> + <zZ>

Cut <Ctrl> + <X>

Copy <Ctrl> + <C>

Paste <Ctrl> + <v>

Delete <Ctrl> + <Del>
Tools

Dot

Line

Box

Circle

Brush

Ruler

Move Area <Ctrl> + <M>

Copy Area <Ctrl> + <O>
View

Show Grid <F4>

Show Coordinates

You can also select these functions from the Toolbox
or the Edit Window Toolbar.

Edit Window Toolbar

The Edit Window Toolbar displays just below the Edit
Window menu bar.

ool lsl@ e 2l post ] 20

Figure 3-9. Edit Window Toolbar

The buttons, from left to right, are as follows:

Pointer Coordinates
Displays the current pointer position in X (horizontal)
and Y (vertical) coordinates.

Drawing Start Coordinates
Displays the starting horizontal and vertical coordi-
nates for the current drawing operation.
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Drawing Size

When the corresponding option is selected, displays
the current ruler length, copy/move area width and
height, line length, box width and height, or circle
radius.

Grid <F4>
Displays/hides the grid (toggle). The grid does not
display for magnifications of 4x and less.

Undo <Alt> + <BkSp>
Undoes the last edit operation.

Down Arrow <->
Decreases the magnification.

Magnification
Shows the current magnification.

Up Arrow <+>
Increases the magnification.

Post
Saves changes made to the character bitmap.

Prev <Ctrl> + <P>

Displays the previous character in the font for editing.
Prompts for confirmation if you made changes to the
current character.

Next <Ctrl> + <N>

Displays the next character in the font for editing.
Prompts for confirmation if you made changes to the
current character.

Transform toolbox

@_,I The Transform tool allows you to change the appear-
ance of single characters or the entire font.
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By Point Size
Current: Hew

w [vE
Ed

By Proportions [%]

AH
g
Filter bitmap

The transformations you can perform are:
Resize Rotate Shift Slant

Darken Lighten Underline Reverse
Filter Outline Halftone Mirror

Use the additional tool options to define
how you want to apply the transformation

Figure 3-10. Transformation tools and options

You can also use the Transforms menu to perform all
the above actions.

The "Transforming fonts" chapter describes in full the
transformation tools and their operation.
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Kill toolbox

E! The Kill tool deletes or blanks a character from the
font, depending on your option selection.

Kill char

Figure 3-11. Kill tool

Character Properties toolbox <F2>

El | Displays the Character Properties dialog box.

= Character Properties

Equiv ASCH Chas | |

Character Number: l:] [Decimal]

[ |tHen
Cell Width: Char type:

+ ‘Honblank
Spacing
Hull

Bazeline Offset:

Blanks Left:

Blanks Hight:

Left Kerning: Floating accent: xc |
anicel
High Accent

Bitmap width: + Mo Accent
Bitmap height: Low Accent

Figure 3-12. Character Properties dialog box
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The Character Properties dialog box contains the fol-
lowing options:

Prev/Next

Selecting the [Prev] and [Next] buttons displays the
Character Properties dialog box for the previous and
next characters in the font.

Equiv ASCII Char
The ASCII representation of the selected character.

Character Number
The ordinate position of the character in the font in
decimal and hexadecimal notations.

Cell Width
The width of the cell the character is in. Also called
the character width or the delta-X of the character.

Baseline Offset

The baseline offset of the character; this is the dis-
tance in dots from the bottom of the character bitmap
to the baseline. The baseline is positive if the charac-
ter sits above the baseline and negative if it sits below
the baseline.

Blanks Left

The blanks left of the character. This is the distance
(in dots) between the left side of the character cell and
the start of the character bitmap.

Blanks Right

The blanks right of the character. This is the distance
(in dots) between the right side of the character bit-
map and the right side of the cell. If the character has
right kerning, this value is negative and the character
protrudes over the right side of the cell.

Left Kerning

The left kerning of the character. This is the distance
(in dots) the character protrudes over the left side of
the cell. This value produces left kerning only after the
font converts. The 9700 family of printers does not
support left kerning.

Bitmap width/Bitmap height
The width and height of the character bitmap in dots.

ELIXIFONT USER GUIDE 3-17



CREATING AND EDITING FONTS

Copy toolbox

Char type
The type of the character, which in this example is
[Nonblank]. You can change the type to [Spacing] for
a spacing character, or [Null] to eliminate the
character.

Floating accent

A flag for distributed printers which instructs the
printer to map accents to a high or low position or to
assign no accent to the character. This option is not
used for the 9700 series printers and refers to the
European ISO standard.

Swap toolbox

el

Allows you to copy a character into any other position
in the font. Select the character to copy, then select a
target position to which you want to copy the charac-
ter. If the target position already contains a character,
the character is replaced.

You can also copy a range of characters to a new po-
sition in a font. Click and <Ctrl>-click to select a range
of characters and then click on a target character cell.
The selected range of characters are copied to new
positions starting at the target character cell.

[0

Merge toolbox

Allows you to swap the positions of two characters in
the font. Select the first character, then select the
second character. The two characters swap
positions.

00
=0

Allows you to load another font and copy the font
characters into your original font. A Load Font for
Merge dialog box displays from which you select an-
other Elixir-format font. After font selection, the
screen splits into Source and Target font windows.
The Target window contains the font you originally
loaded; the Source window contains the font from
which you want to merge.

3-18
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Select the source character you want to merge into
the target font, then select the target character you
want to replace. The source character overwrites the
target character.

The Merge Font and Edit menus contain options for
loading another source font and undoing a merge op-
eration, respectively.

Merging a tall character into a smaller font will verti-
cally stretch all of the cells in the smaller font (see the
following figures for an illustration of the effect of
merging a tall character into a smaller one).

P

37 Hew: 25 Wid 30 HONBLANK

@Bl@] L]
3| 4] 5/ 6/ [7 8] B :a[%]E]

Figure 3-13. Selecting a character for merging
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Figure 3-14. Effect of merging a character

Press <F7> to save the revised target font with a new
name, or <Ctrl> + <S> to save the font with its original
name.

Close the source font window and restore the target
font window to its original size.

Sample toolbox

Displays a font sampling pad in which you can see
how text created with the current font will print.
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Figure 3-15. Sampling pad example

Use the keyboard or click on the characters in the
Character Set window to place the characters in the
sampling pad.

Pull down the File menu and select [Print Sample] to
proof print the sampling pad. When proof printing,
text prints as bitmaps.

Select the [Line] option in the sampling pad window
header to display the baseline when entering charac-
ters, or pull down the View menu and select [Show
Baseline].

Select the [Kern] option in the sampling pad window
header to show the effect of kerning character pairs.
Alternatively, pull down the View menu and select
[Show Kerning]. For this effect to be visible, the bit-
map of the kerned character must extend beyond the
character cell. See the "Glossary" for an explanation
of kerning.
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Font Properties toolbox <Ctrl> + <F2>

IZIIILIII.]' Displays the Font Properties dialog box.
i
Bientation: Hesolution:
PURT « LAMD 240 + 300
IPORT 1LAND 480 600
Pitch: Fixed + . Proportional
Distance Above » Below » Leading  Press for lotal
+ + IE = |Linespacing | 35
Point Size: 7 Change cell width
Pixel Height: 35 * Add Remove
Last character at: Amount: E]
Heades Submenus
Figure 3-16. Font Properties dialog box
The Font Properties dialog box contains the following
options:
Orientation
Specify the font orientation as Portrait, Landscape, In-
verse Portrait, or Inverse Landscape.
Resolution
Specify the font resolution as [240] or [300]. Note that
[480] and [600] options are for future implementation.
Pitch
Specify [Fixed] or [Proportional] fonts. If creating a
fixed-pitch font, a dialog box displays with options for
specifying the fixed cell width in dots, and selecting
the placement of the bitmap in the cell.
Distance Above + Below + Leading
Specify above, below and leading values for line spac-
ing. If you change any of these values, click on the
[Linespacing] button to recalculate the line-spacing
value.
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Point Size/Pixel Height
Displays the point size and height in dots. You cannot
change these values.

Last Character At
Specify the decimal position of the last character in
the font.

Change Cell Width
Specify whether to add or remove from the cell width
the number of dots you enter in [Amount].

Header Submenus

Displays the font header information for 9700,
2700/4045, 4075, and HP PCL fonts. See the "Header
submenus" section of this chapter.

Header submenus

The [Header submenus] option in the Font Properties
dialog box contains font header information for the fol-
lowing fonts: 9700, 2700/4045, 4075, and HP PCL.

Xerox 9700

Displays the Xerox 9700 Font Properties dialog box:

XEROX 9700 Font Properties

it oms:
o

-
Logo Becurity:  |PASWORD

Mmoo [}

Figure 3-17. Xerox 9700 Font Properties
dialog box

The Xerox 9700 Font Properties dialog box contains
the following options:
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Internal Name

Specify a unique 6-character internal name. As the
9700 printer requires each font to have a unique
name, you should change this name if you change the
font orientation, or if you create a modified version of
an existing font. The internal font name automatically
changes to the new file name if you save the font into
a new file.

Revision
Specify a 2-character font revision field for font library
management.

Version
Specify a 2-character font version field for font library
management.

Library
Specify a 10-character font library name for font library
management.

Logo Security

Specify a 10-character logo security information field.
Note that the printer software does not support the
logo security information field.

Memory Size

This option is an information-only statistic displaying
the amount of memory used by the font on a Xerox
9700 printer. This value is computed when converting
to the 9700 output format, and will only display as a
non-zero value if you subsequently reconvert the 9700
font back to Elixir format. If you edit the font in Elixi-
Font, the this option will not reflect any changes you
made.

Xerox 2700/4045

Displays the Xerox 2700/4045/4075 Font Properties
dialog box:
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XEROX 2700/4045/4075 Font Properties

E[:]

Figure 3-18. Xerox 2700/4045/4075 Font Properties
dialog box

The Xerox 2700/4045/4075 Font Properties dialog
box contains the following options:

Internal Name

Specify a unique 20-character internal name for the
font. Change this name if you change the font orien-
tation or create a modified version of this font.

If the internal name on an XES font is defined, saving
the font will not overwrite the internal name. If the in-
ternal name of an XES font is not defined, saving the
file automatically assigns the file name to the internal
name.

Revision
Specify a 1-character font revision field for font library
management.

Underline Offset
Specify a value for the offset of the character
underlines.

Underline Thickness
Specify a value for the thickness of character
underlines.
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Strike Thru Offset
Specify a value for the offset of character
strike-throughs.

SuperScript Offset
Specify a value for the offset of all superscripts.

SubScript Offset
Specify a value for the offset of all subscripts.

First Character
Specify the decimal value of the position of the first
non-null character in the font.

Floating Accents

Select whether or not there are floating accents in the
font to be mapped to characters at print time (for
European ISO fonts). See the "Production and distrib-
uted printer differences" section in the "Frequent Op-
erations and advanced functions" chapter for more
information.

Character Position
Select to map the font to an ISO or IBM character set
at print time. Select [None] to not map the font.

Xerox 4075

Displays the Xerox 4075 Font Properties dialog box:

XEROX 4075 Font Properties

oty o
Encoiog ome
Socwartor

Lhat Set Numher
X Height
Eno Uhararter

Figure 3-19. Xerox 4075 Font Properties dialog box
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The Xerox 4075 Font Properties dialog box contains
the following options:

Family Name
Specify a 20-character font family name.

Encoding Name
Specify a 20-character encoding name.

Security Key

Specify an 8-character security key information field.
Note that the printer software does not support the se-
curity key information field.

Char Set Number
Specify a number for the character set.

X-Height
Specify a value for the X-Height of the font.

Error Character
Specify a number for the error character.

Note that the 4075 is a 240 dot per inch (dpi) printer
and the 9700, 4045, and 2700 printers are 300 dpi.
To print a font on the 4075 the same size as on a
9700, 4045, or 2700, downsize the characters as de-
scribed in the "Frequent operations and advanced
functions" chapter.

Entries in both the 2700/4045 and 4075 menus are re-
quired for a 4075 font.

HP PCL

Displays the HP PCL Font Properties dialog box:
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= HE PCL Fant Properties

HEG7BL

Figure 3-20. HP PCL Font Properties
dialog box

The HP PCL Font Properties dialog box contains the
following options:

Typeface Name
Specify the typeface name (file name of the font).

Typeface
Specify the typeface number.

Symbol Set
Specify the symbol set of the font.

Style
Select this option for italic or deselect this option for
normal.

Stroke Weight
Select the stroke weight (boldness) from the pull down
list.
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4. Transforming fonts

This chapter describes how to use ElixiFont to apply
transformations to single characters or to all charac-
ters in a font.

Transformations are editing functions that change the
printing characteristics of characters. The transforma-
tions you can apply are:

Resize, Rotate, Shift, Slant, Darken, Lighten, Under-
line, Reverse, Filter, Outline, Halftone, and Mirror.

The following figure shows some examples of single-
character transformations.

EE:ExZ EED

] JEE

Figure 4-1. Transformation examples

To apply a transformation:

1. Select either a single character or the entire
font.

To select an entire font, pull down the Edit menu
and select [Select all].

:.G:J 2. Select the Transformation tool.
3. Select a transformation operation from the

toolbox, or pull down the Transforms menu
and select a transformation option.
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.:l:. I 4. Select the options for the transformation from
''''''' " the toolbox.

5. Click on the [Start Transform] button to start
the transformation.

£ Click on the [Stop] button in the toolbox to stop

the transformation during execution or click on

Llr'u:h:ul [Undo] in the toolbox to undo the tre}nsformation

—_ just applied. Note that the undo function does not

reverse a transformation that is stopped during
execution.

The following sections describe each transformation
in detail.

Transformation tool options

This section describes Transformation tool options
that display in the ElixiFont Toolbox.

Transformation tool
options

Figure 4-2. Transformation toolbox
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Resize
Af The Resize transformation allows you to increase or
decrease the size of a selected character or font by up

to 50% more or less than the current point size.
When resizing the entire font, line spacing, cell widths,
and other values are resized proportionally.

If you are resizing the entire font, or increasing the
character size and the enlarged character does not fit
in the character cell, you are prompted for
confirmation.

Note that the Undo operation is not supported for
Resize transformations.

Resize
options

Figure 4-3. Resize options
The Resize toolbox contains the following options:

Resize by Point Size

To resize the character or font by point size, click on
the up or down arrow in the [NEW] option until new
point size displays. Note that the current point size
also displays in the toolbox.
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Rotate

Resize by Proportions

To resize the height and width of a character or font
by proportion, click on [+] to increase the size of the
character or font and click on [-] to decrease the size
of the character or font, then click on the up or down
arrows to specify the percentage to increase or de-
crease the point size.

Filter Bitmap

To remove jagged edges and single bits after resizing,
select the [Filter Bitmap] option to remove single black
bits or deselect the [Filter Bitmap] option to remove
single white bits. Before applying filtering to an entire
font, you may want to apply filtering to a single charac-
ter to see the effect of different filtering options. Re-
peatedly resizing the same font, significantly distorts
the font and is not recommended.

3

The Rotate transformation allows you to rotate a char-
acter or the entire font in increments of 90 degrees.

If you rotate the entire font more than once, cell di-
mensions cannot be preserved and reversing the rota-
tion will not restore the font exactly.

Note that this option does not create a landscape font
from a portrait font or a portrait font from landscape
font. To change the orientation of the font, modify the
[Orientation] option in the Font Header dialog box.

4-4
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Rotate
options

Figure 4-4. Rotate options
The Rotate toolbox contains the following options:

Clockwise
Click on this option to rotate the selected character or
font 90 degrees clockwise. Each time you click on
this option, the character or font rotates an additional
90 degrees.

Counterclockwise

Select this option to rotate the selected character or
font counterclockwise. Each time you click on this op-
tion, the character or font rotates an additional 90
degrees.

The Shift transformation shifts a character or font
within the cells.

If shifting a character extends it beyond its cell, a dia-
log box requests confirmation for increasing the size
of the character cell.
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Shift
options

Figure 4-5. Shift options
The Shift toolbox contains the following options:

Direction
Select a direction to shift: up, down, left, or right.

Amount
Specify the number of dots you want the characters to
shift.
Slant
A The Slant transformation allows you to slant a charac-
ter or font. This feature is useful for creating italic ver-

sions of a character or a font.

A warning dialog box prompts you if slanting a charac-
ter extends it beyond its cell.

Each slant operation adds distortions (like jagged
edges, single bits, etc.) that compound with repeated
operations. Therefore, repeated slanting of charac-
ters is not recommended.
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Slant
options

Figure 4-6. Slant options
The Slant toolbox contains the following options:

Direction
Select the slant direction: [Forward], [Backward], [Up-
ward], or [Downward].

Dots to Slant
Select the number of dots, up to 99, by which you
want the character(s) slanted.

Darken
iy The Darken transformation allows you to darken (em-
A bolden) characters by adding one or more dots next to

existing dots in the character bitmap.
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Darken
options

Figure 4-7. Darken options
The Darken toolbox contains the following options:
Direction
Select the side of the bitmap where you want dots
added.

Number of Bits to Darken
Specify the number of dots to add.

4-8
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Lighten
. The Lighten transformation allows you to lighten (un-
i bold) characters by removing one or more dots from

existing dots in the character bitmap.

(I
ool =

Lighten
options

Figure 4-8. Lighten options
The Lighten toolbox contains the following options:
Directions
Select the side of the bitmap where you want dots
removed.

Number of Dots to Lighten
Specify the number of dots to remove.
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Underline

A The Underline transformation allows you to underline
—_— characters.

Underline
options

Figure 4-9. Underline options
The Underline toolbox contains the following options:

Position
Select the position of the underline above or below the
baseline.

Baseline by
Specify the distance from the baseline.

Thickness
Specify the thickness, in dots, of the underline. The
default is 4 dots.

Width
Select the underline as either the width of the cell or
the width of the character.
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Reverse

The Reverse transformation reverses character cells
by changing black to white and white to black.

If you are reversing an entire font, a dialog box dis-
plays to confirm the operation.

Figure 4-10. Reverse toolbox
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Filter
LE The Filter transformation allows you to apply filtering
eaia] to one or more characters in a font.

Filter
options

Figure 4-11. Filter options

The Filter toolbox contains options for filtering the fol-
lowing: [Sharp Corners], [Hanging Bits], and [Single
Bits].

The following figure shows the filter options:

Hanging

Black/W hiteSingIe Sharp Black

lBIack Sharp White
Corners

Single White

Figure 4-12. Filtering options

Note that the filtering result may not be consistent with
bits that are on outer edges of the character bitmap.
After filtering and performing manual edits, you should
check character bitmaps.
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Outline

ﬂgr'l-. The Outline transformation encloses the character bit-
map with a border and reverses the enclosed area.

Outline
option

Figure 4-13. Outline option
The Outline toolbox contains the following option:
Width of Outline
Specify the outline thickness between 1 and 9 dots.
The default is 2 dots.

The following figure shows the effect of outlining:
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Figure 4-14. Outlining example
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Halftone

A

The Halftone transformation allows you to apply line or
shading patterns to characters.

Halftoning is applied to solid black portions of a char-
acter. If you are halftoning a character that is not solid
black, for example a shaded or previously halftoned
character, only the black portions of the character are
halftoned. When halftoning a spacing character, re-
verse it to black then apply halftoning to the
foreground.

Note that when halftoning an entire font, you may be
required to adjust some character width settings for
correct character fit when placed together.

| PAl3 A ]
&ﬁgﬁﬁ

Halftone

| options
[
| e
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Figure 4-15. Halftone options
The Halftone toolbox contains the following options:

Foreground/Background
Select to apply halftoning to the character bitmap
[Foreground], or the cell [Background].

Outline
Select this option to outline the character bitmap and
then select the number of dots for the width of the
outline.
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Mirror

Line
Select this option to apply halftoning as lines, and then
select the [Style], [Width] and [Separation] options.

Style
Select to apply halftoning using horizontal, vertical, 45
degree or 135 degree lines.

Width
Specify the line width for halftoning.

Separation
Specify the line separation in dots.

Shade

Select this option to apply halftoning using shades,
then click on the up or down arrows to select a shade
pattern number. The pattern displays in the pattern
preview box.

h

This Mirror transformation rotates characters vertically
or horizontally.

Mirror
options

Figure 4-16. Mirror options
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The Mirror toolbox contains the following option:
Direction

Select to mirror the characters horizontally or
vertically.

The following figure shows an example of horizontal
and vertical mirroring of the character G.

G P

C

Figure 4-17. Mirroring example.
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5. Frequent operations
and advanced functions

This chapter describes some examples of frequently
performed actions using ElixiFont.

Changing the font orientation

Changing the orientation of a font is different from ro-
tating the characters in a font. When rotating charac-
ters, the print direction (the direction of advancing
text) remains the same. When the orientation of a
font changes, the print direction also changes. Infor-
mation about the orientation of a font, including the
print direction, is included in the font header.

Font orientation is specified as portrait, landscape, in-
verse portrait, and inverse landscape. The way text
prints on a page depends on the orientation of a page
which can be portrait or landscape. The following fig-
ure illustrates the effect of printing text with different
orientations on portrait and landscape pages.
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Figure 5-1. Portrait and landscape text and pages

To change the font orientation, select either [PORT],
[LAND], [IPORT], or [ILAND] in the Font Properties
dialog box. See the "Creating and editing fonts" chap-
ter for more information.

To distinguish the new font from the original font, use
the [Save Font As...] option to change the font name.
You may want to use a naming convention, such as
using an L suffix for landscape fonts, to distinguish
fonts with different orientations.

To use the new font in Elixir applications such as Elixi-
Form, create a screen version of the font using the
ElixiSys Desktop. See your ElixiSys Desktop and
Converters User Guide for more information.

When converting the font to another format using the
ElixiSys Desktop, the orientation of the output font is
included in the header.

If you create a font with a new orientation and want to
later convert it to Xerox format, change the internal
name of the font (using the [Header Submenus] op-
tions in the Font Properties dialog box), and the DOS
external file name to distinguish the new font from the
font with the original orientation. See the "Creating
and editing fonts" chapter for more information.
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FREQUENT OPERATIONS AND ADVANCED FUNCTIONS

To generate all four orientations, change the font
header orientation and save it as a different name for
each one of the four orientation options. Then use the
ElixiSys Desktop to convert each file.

Note that stem names of Xerox production-printer
fonts can contain only six characters. If the stem
name of a font being converted to Xerox production-
printer format contains more than six characters, the
last (right side) characters are truncated. Check the
font names before conversion.

Changing the width of character cells

After proofing text created by a proportional font, you
may want to change the width of individual cells to
make printed text more appealing.

® To change the width of a character, select it and
change the [Cell Width] option in the Character
Properties dialog box.

®* To change the width of all character cells by the
same amount, change the [Cell Width] option in
the Font Properties dialog box.

® To make the cell widths the same fixed amount,
select [Fixed] in the Font Properties dialog box
and enter the fixed width in the Changing to Fixed
Pitch dialog box.

See the "Creating and editing fonts" chapter for more
information.

Note that if you want to convert your fonts to Xerox
format, Xerox printers cannot accommodate charac-
ters with width, height, or baseline offset larger than
512.
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Changing the baseline offset

The baseline offset refers to where characters sit with
respect to the baseline. There are two ways to
change the baseline offset:

® Change the [Baseline Offset] option in the Char-
acter Properties dialog box. See the "Creating
and editing fonts" chapter for more information.

®  Shift the character up or down using the Shift
transformation. You can also use the Shift trans-
formation to shift all characters in the font by the
same amount. See the "Transforming fonts"
chapter for more information.

Changing the font internal name

Procedures for changing the internal name of a font
depend on whether you want to print the font on a pro-
duction (9700 format) or a distributed (XES) printer.

As printer font names can contain up to six charac-
ters, do not use more than six characters to specify
internal and external names for fonts you want to
convert.

To change the internal font name of a font you want to
print on a production printer:

1. Pull down the Font menu and select
[Properties].

The Font Properties dialog box displays.
2. Select [9700].

The Xerox 9700 Font Properties dialog box
displays.

3. Enter a new internal name in upper case
letters and click on [OK].

To change the internal font name of a font you want to
print on a distributed (XES) or a 4075 printer:

5-4
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FREQUENT OPERATIONS AND ADVANCED FUNCTIONS

1. Pull down the Font menu.
The Font Properties dialog box displays.
2. Select [2700/4045]

The Xerox 2700/4045/4075 Font Properties dia-
log box displays.

3. Enter the new internal name in upper case or
lower case letters.

For easier tracking and management, you may want
to match the internal font name and the external DOS
names.

To change the DOS file name:

1. Pull down the File menu.

2. Select [Save Font As].

3. Save the font with a new name.

Note that when you save a font with a new DOS
name, the internal name is also changed.

Horizontal character spacing

You can change the spacing of individual characters
or the whole font.

To change the character spacing for a single charac-
ter, select a font, pull down the Char menu, select
[Properties], and enter a new value for the [Cell Width]
option.

To change the character spacing for the entire font,
select the font, pull down the Font menu, select [Prop-
erties], and select to [Add] or [Remove] dots from the
[Change Cell Width] option.

See the "Creating and editing fonts" chapter for more
information about these options.
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Null character conversions

You can edit null characters to create spacing and
nonblank characters.

To edit a null character:

1.
2,

Select the null character.

Pull down the Char menu and select
[Properties].

The "Properties of Null Character" dialog box
displays.

In the [Char Type] option, select [Spacing]
and click on [OK].

The null character is converted to a spacing
character.

With the spacing character still selected, pull
down the Char menu and select [Properties].

The "Properties of Spacing Character" dialog box
displays.

Enter a value for the [Cell Width] option and
click on [OK].

Double-click on the spacing character.

Create a nonblank character using the editing
tools.

See the "Creating and editing fonts" chapter for
more information about creating a nonblank
character.
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Production/distributed font conversion

You can convert between 9700 (production-printer)
fonts and 2700/4045 (distributed) fonts using ElixiSys
Desktop.

When converting fonts, consider the effect of the dif-
ferent printer hardware and software on printer output.
For example, the size and shape of dots are different
for different Xerox printer types.

In addition, some early (1984 - 1985) Xerox 4045
printers print at 303 dots per inch, while the 9700 se-
ries print at 300 dots per inch. This one percent differ-
ence may be important in some applications.

Production and distributed printer differences

The following list describes the major differences be-
tween Xerox production and distributed printers.

® The 9700 does not permit characters at decimal
positions 0 - 15, while distributed printers permit
all characters. Converting from a 4045 font to a
9700 font may cause characters to be dropped
unless explicity moved to safe positions in
ElixiFont.

® The maximum length of a 9700 font name is six
characters. The maximum length of a distributed
internal name is 20 characters. DOS file names
can contain up to eight characters plus up to
three characters for the extension.

When converting a font from a distributed to
production-printer format, the first six characters
must be unique.

® Distributed printer fonts, through the 1ISO charac-
ter mapping scheme, support a wide range of
floating accents which are dynamically placed
above characters at print time. In production
printers, accents are part of the character bitmap.
To create accented 9700 characters, use the
[Copy] and [Blend] options.
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Handling overstrike characters: The hardware in-
side a distributed printer can overlay characters to
produce overstrikes, strikethroughs and under-
lines. A 9700 cannot perform these functions. To
generate underlined text on a 9700, use ElixiFont
to create characters with underlining, then convert
the font using ElixiSys Desktop and use the un-
derlined characters on the page.

The Xerox 9700 and Xerox 2700/4045 Font Prop-
erties dialog boxes display the major differences
between the internal fields of the two types of
printers.

These fields are extracted from the appropriate
Xerox font headers and do not affect ElixiFont op-
eration. However, if you convert Elixir fonts to
Xerox format, the values specified for the fields in
the Font Properties dialog box are converted and
included in the Xerox font header. Before speci-
fying or changing any of these fields in these dia-
log boxes, consult your Xerox printer or font
manual.

Working with reversed fonts

The best way to work with reversed fonts is to first re-
verse the entire font to a normal "black on white"
mode. You can then resize, slant, rotate edit, shift
and perform any other operation on the font.

When you have completed your transformations, re-
verse the font again so that the characters are white

on black.

Make sure characters do not partially extend beyond
their cells, for example you should not attempt kerning

on a reversed font.
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Kerning characters

Kerning is the process of adjusting the spacing be-
tween character pairs to enhance readability and to
visually equalize the spacing among all characters
within a line. The amount of space added or sub-
tracted between character pairs is dependent upon
the font and point size used.

There are two types of kerning:

® |eft kerning is when the space between a charac-
ter and the one preceding it is adjusted (usually
reduced).

® Right kerning is when the space between a char-
acter and the one following it is adjusted (usually
reduced).

ElixiFont and Xerox printers fully support right kerning.
To kern a character, decrease the cell width of the
character so that the [Blanks right] option in the Char-
acter Properties dialog box becomes negative and the
character extends beyond the right edge of the cell.
See the "Creating and editing fonts" chapter for more
information about the Character Properties dialog box.

See your Xerox printer manual(s) for more information
about kerning on your printer.

Producing large ascenders/descenders

To have a character whose top or bottom extends be-
yond the top or bottom of the cell, display the Charac-
ter Properties dialog box and change the [Baseline
Offset] to large positive or negative values. This will
cause the character to extend upwards or downwards
beyond the cell.
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A. Keyboard shortcuts

This appendix lists keyboard shortcuts (fast keys)

specific to ElixiFont operation.

To display a pull down menu, click on it or hold down
the <Alt> key and press the underlined letter in the
menu. Set <Num Lock> off for fast keys using the nu-

meric keypad.

Function

Shortcut Key

Copy bitmap to clipboard
(Edit mode)

Copy area (in Edit mode)
Cut area (in Edit mode)
Delete Character

Bitmap

(in Edit mode)
Exit
Go to Previous

page of font characters

Go to Next page of
font characters

Go to First page of
font characters

Go to Last page of
font characters

Grid toggle (Edit mode)

Help

<Ctrl> + <C>

<Ctrl> + <O>
<Ctrl> + <X>
<Del>

<Ctrl> + <Del>

<Alt> + <X>
<Alt>+<F4>
<PgUp>
<PgDn>
<Home>

<End>

<F4>

<F1>
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KEYBOARD SHORTCUTS

Move area (Edit mode)

Next character (Edit mode)

Open

Pan up edit window
Pan down edit window
Pan left edit window
Pan right edit window
Paste (in Edit mode)
Previous character
Properties

Character / CodePoint
Font / CodePage
Save

Save as..

Select / Unselect all

Toolbox show / hide

Undo

Zoom in

Zoom out

<Ctrl> + <M>
<Ctrl> + <N>
<F8>

<up arrow>
<down arrow>
<left arrow>
<right arrow>
<Ctrl> + <V>
<Ctrl> + <P>
<F2>

<Ctrl> + <F2>
<Ctrl> + <S>
<F7>

<Ctrl> + <A>
<F10>

<Alt> + <Bksp>
<Ctrl> + <zZ>

<+>

<->

ELIXIFONT USER GUIDE



B. Conversion chart

You can convert fonts created in ElixiFont to different
formats using the ElixiSys Desktop. The following
chart shows the supported conversions.

ELIXIR | Screen | WIN HP 4045 2700 | 370 | 9700 | 4075 | 5Wor
PCL 0 d

TO TO TO TO TO TO TO
TO TO TO

ELIXIR

X

Screen

WIN

X | X[ X | X

HP PCL

4,045

2,700

X[ XX ]| X[X]X]X

3,700

X[ X[ X[ X[ X]X]|X]|X

9,700

X I X[ X X[ X]X]X|[X]X

4,075

X | X | X[ X | X | X

5Word

X[ X[ XXX ] X]|X|X[X][X
X[ X[ X ]| X ]| X]|X

PS
Type
3
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Glossary

accent

A mark over, under, or through a letter that indicates
the vocal quality or sound value (inflection, tone,
stress, etc.).

ascender
The part of a lowercase letter which extends above
the x-height.

Ascender Baseline

\

x-height A !

Figure G-1. Ascender and baseline

baseline

An imaginary line which is used to position a charac-
ter. Characters may rest on the baseline or extend
above or below it. Characters are normally positioned
so that their baselines are aligned. Such characters
are said to be base aligned.

baseline offset

The distance (in dots) from the bottom of the charac-
ter bitmap to the baseline. The baseline offset is posi-
tive if the character sits above the baseline and
negative if it sits below the baseline.

bitmap
A two-dimensional array of dots which is used to rep-
resent each character in a computerized font.

blanks left
The distance (in dots) between the left side of the
character cell and start of the character bitmap.
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blanks right

The distance (also in dots) from the right side of the
character bitmap and the edge of the cell. If the char-
acter has right kerning, this value is negative and the
character extends over the right side of the cell.

bold
A darker version of a font or character formed using
heavier strokes. See also weight.

cell

An invisible frame surrounding a character whose
width equals the set width and whose height equals
the line spacing of the font.

cell height
The cell height of a character is equal to the line spac-
ing of the font.

cell width
The width of a character cell, also called the set width,
character width, or delta-x.

centralized printer

A classification of high speed Xerox printers. Exam-
ples of centralized printers are the 4050, 4650, 4090,
8700, 8790, 9700, and 9790. See also distributed
printers.

character cell
See cell.

character header

A record stored in the computer for each character
which contains information such as the set width and
the position of the descender relative to the baseline.

character width
The width of the cell containing the character. This is
also called the delta-X or set width of the character.

debolden
To lighten a character by removing bits from it.

delta-x
The delta-x of a character is the same as the charac-
ter width or set width.

GLOSSARY-2
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descender
The part of a letter which extends below the baseline.

Descender —— I g i

Figure G-2. Descender

distributed printers

A classification of Xerox printers that are smaller and
slower than Xerox centralized printers. Examples of
distributed printers are the 2700, 3700, 4030, and
4045.

dot
See point.

embolden
To darken a character by adding bits to it. See also
bold.

fixed-pitch
See monospace.

font
A complete set of characters of a particular font fam-
ily, size, typeface, and orientation.

font family
A set of fonts with similar design characteristics, usu-
ally including many sizes, typefaces, and orientations.

font header

A record within the computer which contains informa-
tion applicable to the entire font such as the font
name, the line spacing, and the orientation.

halftoning
The application of line or shading patterns to a char-
acter so it may appear gray or textured.

inverse landscape/portrait orientation
Refers to the print direction of fonts as shown in the
following figure.
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Portrait
2 = Landscape
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Portrait Page Landscape Page

Figure G-3. Page and print orientations

kerning

Kerning is the process of adjusting the spacing be-
tween certain character pairs to enhance readability
and to visually equalize the spacing among all charac-
ters within a line. The amount of space added or sub-
tracted between certain character pairs is dependent
upon the font and point size used.

Left kerned f

l

Right kerned f

Figure G-4. Left and right kerning

landscape orientation
Refers to the print direction of fonts. See figure G-3.
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leading

The amount of white space placed at the top or bot-
tom of characters for aesthetic effect, to improve
readability, and to prevent overlapping between suc-
ceeding lines. Line spacing is usually equal to the
point size plus the leading.

line spacing

The distance between succeeding lines of text when
printed on a page. In other words, the line spacing is
the distance from the top of the characters on one line
to the top of the characters on the next line.

monospace
The characteristic of a font family whose characters
are all assigned the same horizontal spacing (also
called fixed-pitch).

mirroring
The rotation of a character so that its top becomes its
bottom or its right becomes its left.

nonblank character
A printable character with a bitmap containing a char-
acter or symbol.

null character
An unprintable character that occupies an unused po-
sition in a font.

orientation

The orientation of a font is the direction of the type in
reference to the upper left corner of a portrait page.
See figure G-3.

overstrike
To print characters over each other.

pica
One picais 12 points or 1/6 of an inch. The length of a
printed line of characters is measured in picas.

pitch
The size (specifically the width) of a monospaced font
in characters per inch.
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pixel

The smallest mark that can be printed. A pixel is
sometimes referred to as a dot. Character bitmaps
are made up of dots or pixels. The word pixel is a con-
traction of picture element. A pixel can contain addi-
tional information such as color and can be larger than
one bit while still representing one dot.

point

The size of the characters of a font when they appear
on paper is given in points. One point is 1/72 of an
inch or 0.352 mm.

point size

The size of a printed character in points from the top
of the ascender to the bottom of the descender. Thus,
if the characters in a font are, on average, 1/2 inch
high when printed, the font is said to have a "point size
of 36" or to be a "36 point font."

portrait orientation
Refers to print direction of fonts. See figure G-3.

proportional spacing

The characteristic of a font family, each character of
which is assigned its own horizontal spacing. Propor-
tional space fonts are aesthetically more pleasing and
are easier to read. The text in this guide is proportion-
ally spaced.

reverse
To switch a character from black on a white back-
ground to white on a black background black, or vice
versa.

sans serif
Without a serif. See serif.

GLOSSARY-6
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serif
A short stroke that projects out from the main part of a
character.

Serif

d d

Serif font Sans serif font

Figure G-5. Serif and sans serif

set width

The distance from the start of the character cell to the
beginning of the next character cell. Also called the
character width or delta-x.

spacing character

A blank character that is used for positioning charac-
ters on a line. These characters do the same thing as
a space key on a typewriter. Proportional fonts contain
spacing characters with different widths. An em space
is as wide as the "M" character, and an en space is as
wide as the "N" character.

style

A modified version of a typeface. An example of a
style is Italic. Thus, a Press Roman typeface may be
in the Italic style.

typeface
A unique design for printed letters, such as Press
Roman.

underline
To place a line under text, usually for emphasis (also
called underscore).

weight
The thickness of a font which can be changed by em-
boldening or deboldening characters in a font.

x-height
The height of the lowercase x character. See figure
G-1.
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A

ascenders, 5-9

B

baseline offset, 3-17, 5-4
Bitstream FaceLift fonts,
3-1

blanks left, 3-17

blanks right, 3-17

blend a character, 3-12
brush, 3-12

C

cells, 3-3, 5-3
changing cell width, 5-3
Char menu, 2-8
character
baseline offset,
3-17,5-4
cells, 3-3
delete, 3-16
edit, 3-9
nonblank, 3-7
null, 3-7
spacing, 3-3, 3-7
width, 3-17
Character Properties
dialog box, 3-10
Character Properties
tool, 3-16
character width, 3-17
conventions
display, 1-4
typographical, 1-4

Index

converting
centralized/distributed
fonts, 5-7

copy a character, 3-18
Copy tool, 3-18
creating a new font, 3-4
customer support, 1-2

D

darken/embolden, 4-7
delete a character, 3-16
delta-X, 3-17
descenders, 5-9

draw a circle, 3-12
draw a dot, 3-11

draw a line, 3-11

draw a rectangle, 3-11

E

Edit menu, 2-7
Edit tool, 3-9
Edit tool options, 3-10
Edit Window menu bar,
3-12
Edit Window Toolbar,
3-13
editing a font, 3-9
editing tools, 3-8
ElixiFont
environment, 1-3
exiting, 1-9
font basics, 3-1
Font Window menu
bar, 2-6
installation, 1-7
keyboard shortcuts,
A-1
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INDEX

main screen compo-
nents, 2-1
menu bar, 2-2
overview, 1-1
starting, 1-7
Toolbox, 2-5, 3-8
tools, 2-5, 3-8
ElixiFont main screen,
1-8
ElixiFont menu bar, 2-2
ElixiForm, 1-3
ElixiGraphics, 1-3
Elixir Fonts folder, 1-8

F

fast keys, A-1
File menu, main screen,
2-3
filter, 4-12
floating accent, 3-18
font basics, 3-1
Font menu, 2-7
font orientation, 3-22
font properties, 2-7, 2-8
Font Properties dialog
box, 3-5
Font Properties tool,
3-22
font statistics, 2-7
Font Window menu bar,
2-6
fonts
ascenders, de-
scenders, 5-9
change baseline off-
set, 5-4
change cell width,
5-3
change internal
name, 5-4
change orientation,
5-1
character properties,
3-10
character spacing,
3-7
creating, 3-4

editing, 3-9

horizontal character

spacing, 5-5

internal name, 3-24,

3-25,5-4

kerning, 3-17, 5-9

landscape, 5-1

loading, 3-6

nonblank character,

3-8

null character, 3-7,

5-6

orientation, 3-22

portrait, 5-1

rotate characters,

5-1

statistics, 2-7

transforming, 4-1
framing window, 3-10

G
grid, 3-14

H

halftone, 4-15

HDR files, 2-3, 3-6
header submenus, 3-23
Help, on-line, 1-5

Help menu, 1-5, 2-5
horizontal character
spacing, 5-5

HP PCL, 3-27

installation, 1-7

inverse, 5-1
landscape, 5-1
portrait, 5-1

K

kerning, 3-17, 5-9
keyboard shortcuts, A-1
Kill tool, 3-16

INDEX-2
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L

landscape, 5-1
left kerning, 3-17
lighten/debold, 4-9
loading a font, 3-6

magnification, 3-10, 3-14
main screen, 1-8, 2-1
menus
Char, 2-8
Edit, 2-7
File, main screen,
2-3
Font, 2-7
Help, 1-5, 2-5
System, 2-3
Transforms, 2-8
Window, 2-5
Merge tool, 3-18
merging characters, 2-7

R

reset to defaults, 2-4
resize, 4-3, 5-7
reverse, 4-11, 5-8
rotate, 4-4

ruler, 3-11

S

Sample tool, 3-20
sampling pad, 3-21
save configuration, 2-4
screen fonts, 5-2
select all, 2-8

Select tool, 3-8

shift, 4-5

shortcuts, keyboard, A-1
slant, 4-6

support, customer, 1-2
Swap tool, 3-18
System menu, 2-3

mirror, 4-16 T
o) Toolbar, 3-13
Toolbox, 2-5, 3-8
on-line Help, 1-5 To?lbox options, 2-6
: y tools
outline, 4-13 Blend, 3-12
Character Proper-
P ties, 3-10
. Copy, 3-18
pqrttraltaf:';%l £ D?gx brush, 3-12
B:Qp(;tiéserences' i Draw circle, 3-12
character, 3-10 Draw dot, 3-11
font, 2-7, 2-8 Draw line, 3-11
Font Properties dia- g_rﬁ'v rectangle,
log box, 3-5 Edit. 3-9
Font Properties tool, X .
3.2 Font Properties,
Properties of New ii_II223-16
Font dialog box, 3-4 Mér o 318
Properties of New Font R Ig '311
dialog box, 3-4 uler, o-
Sample, 3-20
Select, 3-8
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Select area, 3-11
Swap, 3-18
Transform, 3-12,
3-14
Transform tool, 3-14
transformation options
darken, 4-7
filter, 4-12
halftone, 4-15
lighten, 4-9
mirror, 4-16
outline, 4-13
resize, 4-3
reverse, 4-11, 5-8
rotate, 4-4
shift, 4-5
slant, 4-6
underline, 4-10
Transformation Toolbox,
30
transforming fonts, 4-1
Transforms menu, 2-8

U

underline, 4-10
unselect all, 2-8
usage switches, 2-3

w

Window menu, 2-5

X

Xerox 2700/4045, 3-24
Xerox 4075, 3-26
Xerox 9700, 3-23
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